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APPENDIX 17A – NETWORK COUNT ATTRIBUTION 
 
 
Network Creation 
 
A network to be used for both Visum and ArcGIS processes can be created from an all 
streets statewide network. For example, for the Newport model, the TomTom all streets 
network was chosen and then clipped to the model or project area; in some cases a 
different original network may be chosen for the base network. If the user desires, a base-
map of OR-Trans (already a shapefile) can be clipped and used in ArcGIS in place of the 
TomTom all streets network. The following covers network creation using both 
processes. Although networks are typically created in ArcGIS using already created 
shapefiles, creating a shapefile from a Visum network is uncommon but not unheard of.   
 
Network Shapefile Creation in ArcGIS 
 
After a base network has been decided on, a study network needs to be created. It is 
necessary to clip the chosen network down to the study area to limit the amount of extra 
space taken by the network and to limit the amount of time it takes to load the network in 
ArcGIS.  
 

1. Open ArcGIS and load the desired boundary file (e.g. of  a city, a model, a 
county) of the network. Most of these are available on the GIS drive or through the 
ODOT GIS toolbar. A model boundary will only be available if there is a current 
model existing for the study area.  

 
2. Open the base network file. To the 
right is a screenshot of the OR-Trans 
Network at the statewide level. This is 
why it is necessary to clip to the study 
area. The thousands of extra roadways not 
only take up storage space but they also 
take an exponential amount of time to 
load.  
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3. Zoom into the study area. And use the 
select by location tool to select the portion of the 
network that is within the boundary file.  

 
 
 
 
 
 
 
 
 
 
 

4. Right click the base 
network layer and choose to 
export the data. Make sure 
‘selected features’ is selected in 
the Export Data popup. Select 
the appropriate location to save 
the new shapefile. (The  original 
roadway network can now be 
removed as well.) 

 
 
Network Shapefile Creation from 
Visum  
 
Creating a network shapefile from a Visum all-streets model, although not unheard of, is 
uncommon. The below steps cover the basic process if this is desired. A shapefile created 
from Visum can be directly imported into an mxd file in ArcGIS, and used similarly to 
the shapefile created from the above directions.  
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1. Open the Visum Version file, and 

make sure there are no selections 
or filters currently being used. Do 
this by making sure there are no 
“red dots” on the right side of any 
of the network elements and also 
by making sure there are no 
“filter funnels” selected.  

 
 
 
 
 
 

2. Select File→Export→Shapefile 
and navigate to the folder where 
the shapefiles are to be stored.  
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3. Choose which shapefiles that 

need to be exported. If both 
nodes and links are chosen, 
they will be exported as two 
separate shapefiles. Particular 
attributes can be chosen for 
export to the shapefile by 
utilizing the columns 
selection.  

 
 
 
 
 
 
 
 

4. This creates the shapefile; 
simply bring it into the 
chosen *.mxd file with the 
other shapefiles. 

 
Network Count Attribution 
 
For use in Visum or ArcGIS, counts must be added to the network. Instructions on how to 
obtain counts from OTMS are in Appendix 3C – OTMS Program Count Report Guide.  
 
After gathering count data, the amount of time needed to attribute counts to the network 
in ArcGIS or Visum depends on a number of different elements. The first and most 
obvious is how many count locations are in the project area. If entering and exiting 
volume are dealt with rather than turning movements the spreadsheets identified below 
can be used to help with the processing of the count data. The more detailed the process 
is the more demanding it becomes. Using the spreadsheets is an automated and efficient 
method to help the analyst process counts. The spreadsheets go through each count and 
separate out directions and summarize the count information.  
 
The spreadsheets also allow a user to process the entering volumes for an intersection 
count in a matter of minutes; currently there is only a semi-automated process for exiting 
volumes. The process for creating the count locations in both ArcGIS and in Visum is 
very similar. Due to the different types of counts that are available, the spreadsheets were 
created to help ease the burden of processing the counts and readying them to be 
attributed to the network. This process will be updated when more spreadsheets become 
available for more detailed count processing.  
 
Before counts can be attributed to a network they need to be taken. Work with the ODOT 
traffic counting unit to make sure the counts are taken in the correct location, correct time 

https://www.oregon.gov/odot/Planning/Documents/APMv2_App3C.pdf
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of year and that the correct kind of count is taken. Once the counts have been taken and 
entered into OTMS then they can be pulled, processed and attributed to the network. If 
new counts are not being taken the statewide count shapefile will help in locating 
available counts.  
 
 
Visum Count Attribution 

 
Once the needed count locations are identified and counts have been pulled, they will 
need to be “pre-processed” before they can be added to a Visum Network. The 
spreadsheets discussed below are designed to help in this process and to help the analyst 
process the different count types available. Entering volumes from turning movement 
counts can be calculated using the existing spreadsheet, but exiting volumes must still be 
created by hand.  The spreadsheets do not currently offer a way to separate out turning 
movement information; this information must be entered by hand if it is desired. These 
spreadsheets simply create files that contain count location information as well as 
entering and exiting volumes for the intersection for each hour of count data.  

 
The available spreadsheets create files that contain count location information as well as 
entering and exiting volumes. For the process for attributing count information in Visum 
refer to Excel Processor Guidelines.  
 
Excel Processor Guidelines 
 
A number of count processors have been created to facilitate setting up count files for 
import into Visum or ArcGIS. 

Excel Tube Count Processor (ATR Edit Sheet processor) Spreadsheet 
 
This processor cleans empty information from the OTMS ATR Edit sheets and 
summarizes the data. It can be used on a single ATR Edit sheet, although it is designed to 
be used to process multiple files at once in order to increase efficiency of count 
processing. This process also adds a VISUM ID for the count locations in VISUM.  
 

5. Pull the appropriate counts from OTMS. For this processor the counts should be 
pulled as “Volume by Hour by day for Month” as a *.csv formatted file. As the 
directions state above, in order to pull multiple reports at one time using the *.csv 
output, the date range pulled is probably many more days than actually contain data. 
Many of the spreadsheets created will look like the figure below.  

https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
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6. If the Excel spreadsheet is pulled, the file will contain a tab for the combined 
direction and one for each direction for each of the sites. It is possible for a 
spreadsheet to only contain one direction and a combined tab. This would imply that 
the count was pulled wrong or that there was in-fact only one direction counted.  
 

7. Make sure that all the tube counts are in the same folder. Then place the tube 
processor in a folder just above the folder that contains the tube counts.  

 

 
 

8. Open the tube processor spreadsheet and click the “Clean ATR Edit Sheets” 
button.  
9. This will bring up a browser window. Navigate to the location where your counts 
are stored. There will not be anything in the folder (this is normal). The browser is 
just there as a way to set a path for Excel to find the files (the files are still there.) 
Click OK. 
 

 Due to the fact that sometimes macros fail, it is suggested that the counts 
you are wanting to process be COPIED into a separate folder for 
processing, keeping a folder with “raw” data. This will allow for a raw 
dataset to remain unprocessed in case there is an error in running the macro. 
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10. This removes all the empty (un-needed) cells from the spreadsheets and also 
removes any empty sheet within each of the workbooks within the specified folder. 
(This spreadsheet processes as many files as were placed in the folder).  

 
11. When the “cleaning” macro is done running, a pop-up will indicate if there were 
any files with errors. 
 
12. If there was no data 
pulled for a site and the 
sheets were empty it will 
tell how many instances 
occurred and will not save 
the changes to them. 

 
13. By not saving changes, 
the user can now go into the 
folder that contains the now “clean” counts, sort on the date and easily find those that 
have not been edited in the last few minutes and open them to find out what the bad 
data is. Most of the time this means that there was no data at the tube for the dates 
pulled, so check the count dates, sometimes there is bad count data and the count unit 
will not enter it into OTMS because of the bad data.  
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14. If there were files that were not cleaned, investigate further why they were not 
cleaned. In the example above, the file contains no data, and therefore is not relevant.  
 

15. Move files that contain “bad” data into a separate folder so the summarize 
processor does not try to summarize them.  
 

16. Once you have dealt with the spreadsheets that have “bad data”, click the 
summarize data button in the processor spreadsheet. 
 
17. This will again bring up a browser window. Navigate to the location where the 
counts are stored. There will not be anything in the folder (this is normal). The 
browser is just there as a way to set a path for Excel to find the files. Click OK. 
 

18. This will now process the good “clean” counts and break down the count 
information. This creates a csv file with a summary of the count information. This 
count information is now ready to be used in VISUM. 
 
19. After summarizing the 
data Excel will again kick out a 
popup to tell how many files it 
has processed, and where it 
saved the summary csv. It 
automatically saves the csv in 
the same folder the counts are 
in and then opens it. This 
allows the user to obtain an overview if it is summarizing all of the counts.  

 
 
 

Excel Turn Count Processor (Intersection Video or TimeMark Count) Spreadsheet 
 

https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
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This processor summarizes the entering volume per leg. It does not summarize turning 
movements or exiting volume. This spreadsheet breaks down the entering volume for the 
intersection for each leg. It also creates a VISUM count ID for each count location.  
 

1. Make sure that all the intersection counts are in the same folder. Then place the 
turn processor in a folder just above the folder that contains the intersection 
counts.  

 

 
 
2. Open the Turn processor, and click the summarize data button. This will bring up 

a browser window. Navigate to the location where your counts are stored. There 
will be not anything in the folder (this is normal). The browser is just there as a 
way to set a path for Excel to find the files (the files ae still there). Click OK. 

 

 
 

This will create a 
summary for each 
direction summing the 
total entering volume into 
each leg. When the 
spreadsheet is done 
summarizing the files 
within the specified folder 
a popup will outline how many files have been processed and where the csv 
summary has been saved. It will then open the csv for review.  

  

1. Due to the fact that sometimes macros fail, it is suggested that the counts 
that are to be processed be COPIED into a separate folder for processing, 
keeping a folder with “raw” data. This will allow for a raw dataset to remain 
unprocessed in case there is an error in running the macro. 
 

https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
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Exiting Volume Calculation Spreadsheet 
 
A spreadsheet is available to help with the creation of the Visum IDs and some other 
basic information. The count information must still be hand entered into the spreadsheet 
but the macros enable the Visum ID and other information to be calculated, and exported 
in the same format of the first two.  
 

1. In the Exit Visum ID spreadsheet, there are seven greyed out columns that do not 
require any entry by the user. This spreadsheet requires a new row for each 
exiting direction. For an intersection with four legs this means there will be four 
rows with the same SiteID, Name, DateRange, and HwyNo. The only items that 
will change for each row will be the direction and the hour counts.  

 

 
 

2. Open two instances of Excel; this will allow placing an open workbook from 
Excel on each screen if there are dual monitors available.   

a. To do this go to the Start menu and open Excel. Once it is completely 
open, open a second instance in the same way. This is the only way to be 
able to have two instances of Excel open.  

b. In the first instance, open the Exit Visum ID macro enabled spreadsheet, 
and in the second open the first intersectional count. (Hint: Go to an 
Window Explorer window and double click the two files, they will both 
open in the first instance of Excel; Use the open function in Excel or drag 
and drop the file in Excel.) 

 

 
 

3. Using the information from the top of the Turning Movement Summary 1 tab, 
place the appropriate information into the Visum Exit spreadsheet. (Note: The 
date field needs to be typed using the same format as provided in the turning 

https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
https://www.oregon.gov/ODOT/Planning/Documents/CountProcessors.zip
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movement summary tab. MM/DD/YYYY-MM/DD/YYYY). If the format is 
placed differently the macro may error out or cause incorrect results.  

 

4. When entering in the direction, these must be chosen from a drop down menu and 
is associated with the direction of travel. For example, SB means a southbound 
vehicle count.  

 
5. Using the Turning Movement Summary 1 tab, summarize each hours exiting 

vehicles. The easiest way to do this is to create an “Exiting” volumes group of 
columns, add up each exiting leg and the use the fill down option to fill down to 
all 24 hours.  

 

 
 

 
 

6. After placing the formulas in the first row, highlighting the four new cells and 
hovering over the bottom right corner, the cursor will change to a black crosshair. 
Double click and it will fill down to the last row.  
 

7. After filling down for each 15-minute period, the hour values must be calculated. 
It is easiest to do this by again utilizing Excel’s fill down option. This time only 
place a formula in the first hour row, and fill down from the top.  

          

 
 

8. The easiest way to move this information to the Visum Exit ID spreadsheet is to 
then filter the hour exit volumes, and remove the blanks. Then copy and paste it 
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within the same spreadsheet, but instead using the past special and pasting only 
values, and then copy the pasted values and paste them transposed. This allows all 
directions for the intersection to be pasted in at the same time.  

 
9. Below you will find an example of one full intersection entered into the 

spreadsheet.  
 

 
 

10. After completely entering in the intersectional counts into the spreadsheet press 
the generate info button. This will fill in the greyed out cells.  

 

 
Figure 1:  Generated information after all intersections have been added. 

 
11. Next by clicking the ‘Save File and Clear Sheet’ button the spreadsheet will kick 

out a new csv file that contains the calculated information and also will clear the 
ExitVisumID spreadsheet and then open the new csv file that is ready to add 
headings to and place into the desired visualization tool.  

a. If placing the counts in ArcGIS continue to Attachment A.  
b. If placing the counts in VISUM continue to the next section, Count 

Locations in VISUM. 
 
 
Count Locations in VISUM 
 
Counts must be placed on the VISUM network, by hand and individually. These count 
locations are directionally specific. Therefore for each bi-directional tube count there will 
be two VISUM count locations. This also means that for a four-legged intersection, there 
will be a total of eight counts placed on the VISUM network for a single intersection 
count in OTMS.  
 
The count processors that were run in the above steps summarize the counts directionally 
so the total number of results in the spreadsheets is the total number of count locations 
that will be needed in VISUM. The best way to start this process is with a shapefile that 
contains the locations of the counts.  
 



13 
Analysis Procedure Manual   Last Updated 05/2022 
Appendix 17A Network Count Attribution 

1. Open the count shapefile in ArcGIS (or open the .dbf file in Excel) to make sure 
that the OTMS ID is an attribute within the shapefile. If it is not, or the shapefile 
does not exist, create a shapefile that contains the location of the counts, along 
with the OTMS ID associated with each count. This helps visually in VISUM 
when placing counts.  

 
2. Open the VISUM network, and select 

network, POI categories. 
 

  
 
 
 
3. Create a new category called 

Counts. Make sure the super 
category is left blank.  

 
 
 
 
 
 
 
4. In the file dropdown menu choose File→Import→Shapefile.  

 
 
 
 
 
 

 
5. Navigate to the location of the 

shapefile. 
 
 
 

6. In the read shapefile popup 
menu check the “Read 
additively” box. Then from the 
dropdown box next to read as, 
choose POI. The POI option 
will not be there unless the read 
additively box is checked.  
Then a new dropdown menu 
called POI category will 
become visible. Choose the POI category counts that was created in Step 3.  
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7. In the Read Attributes 
browser select “new” 
and choose the type of 
input for each attribute 
to be brought in from 
ArcGIS.  

 
 
8. Edit the graphic parameters of the new POIs so that they display as their OTMS 

ID instead of the default red star.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. Open the Excel workbook that contains the count locations that are to be added  

(one of the 3 created in the above steps). Have VISUM open on one screen and 
the Excel spreadsheet on the other.  
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It is suggested that the intermediate step of combining the information 
created from the three spreadsheets be taken. This way all count locations 
are in one spreadsheet instead of three. Those counts processed with the 
tube processor will not have a “leg”, “name” or a “month” attribute 
column. Therefore combining the spreadsheets will require some simple 
formatting. 
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10. Start by making sure 
that there are no 
selections made. 
Check that there are 
no red dots next to 
any of the network 
objects in the 
network toolbar.  

 
 
 
 
 
 
 
 
 

11. Using the multi-select tool ( ) make a selection of the area that is started 
from:  

a. By working on only a portion of the project it makes it seem less 
overwhelming.  

b. In working on only a selection of the network, it allows the analyst to 
focus on the smaller area. The biggest thing is to remember to re-select all 
before continuing on to the next task. 

c. Save out the current selection, so that if something happens the user can 
always come back and be working on the same selection that was started 
with. Do this by selecting the “save spatial selection button from the 
multi-select toolbar).  

 

 
 

12. Select count locations on the network, and choose the insert mode (which cross).   
 

13. Starting on one end of the selection, work across it, stopping at areas that have a 
POI of a count location.  
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14. At each POI count 
location insert the 
appropriate count 
locations. Using the 
Direction column to 
know which leg the 
count goes on if it is 
a turn count. If it is a 
tube count the 
OTMS ID will tell 
which leg to place 
the count on.  

 
 
 
 
 

15. Click on the side of the 
link associated with the 
count to add a new count 
to the network. Put the 
appropriate VISUM ID 
number in the number 
field, leave type as 0, Code 
can be left blank, the 
Name field can be left 
blank.  

 
 
 
 
 
 
 
 
 

 
 
 

If the count is a tube count and there is a need for the name , it will have to 
hand entered into the name field. If this was an intersection count, or there 
is not a need for the name of the intersection, there is no need to enter the 
name field because it will be imported when the count information is 
imported.  
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16. For each tube count there will be two 
count locations that need to be added to 
VISUM. For each intersection count there 
will need to be four count locations added 
in VISUM. For example, in the above 
figure the OTMS ID 41053 would have 
two count locations associated with it in 
VISUM. The two count locations 
(10410530 and 10410531) represent the 
entering and exiting vehicles. The counts 
are placed link specific. So in the case of 
the above example, once counts are placed 
the intersection would look like the figure 
below.  

 

 
 

17. After inserting the count locations in the current selection, click the multi select 
tool. 

a. Then select the 
invert spatial 
selection 
button.  

 
b. Make sure the “set 

spatial selection to 
exclusive state” tool 
is selected.  

 
c. Select a new section to begin work on and return to step 14.  

 
18. Once all the count locations are created in VISUM, the attributes and therefore the 

count information from the spreadsheet can be brought into VISUM.  
 

19. If the three spreadsheets have not been combined into one single spreadsheet, this 
must be done now.  

 

2. The best way to make sure the VISUM IDs remain the same between the 
Excel spreadsheet and VISUM is to copy and paste from the Excel worksheet 
directly into VISUM. 
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20. Insert a row 
above row 
number one.  

 
 
 
21. Make sure that 

the VISUM_ID column is in column A.  
 

22. In cell A1 type $VISION 
 
23. In cell A2 replace VISUM_ID with $COUNTLOCATION:NO 

 

 
 
24. Select and copy all cells that contain data.  

 

 
 
  

3. Do not simply select all cells. Sometimes VISUM has issues when trying 
to paste in a bunch of empty cells. 
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25. In VISUM, right click on 

Count Locations in the 
network toolbar and select 
List.  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
26. In the List (Count Locations) tab, choose the paste button.  

 

 
 
 
27. This will bring up the 

‘Read Attributes’ 
table. This screen is 
where the specific 
types of the attributes 
are defined. Those 
that pop up in the 
“Target attr.” column 
mean that there is 
already an attribute 
defined with the exact 
name. In the case of 
Name and Code this is 
on purpose.  
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28. To define a new 
attribute click 
new in the far 
right column and 
define the type 
(integer, text, 
number with 
decimals etc.) of 
the new attributes.  

 
29. After clicking OK, VISUM may warn the user when there is an object in the 

spreadsheet but not in VISUM. Write down the ones that cause an error and look 
more into it once the import is complete.  

 
30. After importing the data, review it by clicking on the select attributes button         

( ) and selecting those user defined attributes that were just added.  
 

 
 

31. It is best to do some spot checking, just to make sure that the counts were placed 
in the right location and that when then number for a count location was chosen, a 
number was not swapped.  
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ArcGIS Count Attribution 
 

Similar to the Visum process, counts used in ArcGIS will need to be “pre-processed” 
in a nearly identical fashion in order to be properly attributed to the network. As 
mentioned above, there are spreadsheets available to help with the “pre-processing” 
of a few different types of counts. The spreadsheets were originally created to help 
with model creation in Visum therefore there are some cleaning steps that will need to 
be completed in order to best use them in ArcGIS. The following is a how to process 
for attributing the counts to network in ArcGIS after following the steps provided in 
Excel Processor Guidelines.  

 
 
This process begins with pulling counts, and using the provided Excel spreadsheets to 
process the counts. For instructions on how to pull the counts see Appendix 3C – OTMS 
Program Count Report Guide.  
 

1. Process and aggregate the counts into one single spreadsheet. A picture of a final 
spreadsheet can be found below. The Visum ID is simply an ID used because each 
SiteID will have multiple rows and is no longer a unique identifier. (This heading 
could be changed to any project appropriate heading).  

 

 
 
2. Open the spreadsheet that was saved back in the count instructions, which 
contains Latitude and Longitudinal information for your counts. (The clipped 
statewide count shapefile).  

 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.oregon.gov/odot/Planning/Documents/APMv2_App3C.pdf
https://www.oregon.gov/odot/Planning/Documents/APMv2_App3C.pdf


23 
Analysis Procedure Manual   Last Updated 05/2022 
Appendix 17A Network Count Attribution 

 
3. Copy the Site Number, Axle Factor, 
Lat, Long, Last Short, and Category 
information and paste it into a separate tab 
in the combined count sheet file.  
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

4. Once it is in the count sheet, it  
can be used to utilize VLOOKUP in 
Excel to be able to gain location 
information and other needed 
details.  

 
 
 
 

5. Select the Lat, Long, and 
OTMS ID information and “Name” 
it.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Add new columns to bring the new information into the spreadsheet.  
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7. Use VLOOKUP on the count sheet to lookup the count location information 
from the “Named” table.  
 

 
 
 

 
 

8. Save the file.  
 

9. Open ArcGIS and click cancel when it prompts you to choose an mxd file to 
open.  
 
10. Right click in the center of the screen and click data frame properties.  
 
11. Choose the coordinate system tab.  
 
12. In the coordinate system box, expand the Predefined folder, then Geographic 
Coordinate System, then North America, then NAD 1983. 

 
13. Click File→add data→XY Data and navigate to the spreadsheet just created with 
the count data and Latitude/Longitude information.  

Counts that are tube counts need to be axle factored. The column titled 
Axle_FactorID will contain the OTMS Site ID of the count number to use 
for an axle factor if one is required for the latest count. If the column 
contains a “-“ as shown above, then the count is a class count and does not 
need to be axle factored.  
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14. Right click on the newly added XY data and select Data→Export Data. 
 
15. Choose the data frame for the coordinate system, and use the folder button to 
navigate to the folder that will be used to save the shapefile.   
 
16. Choose to add the shapefile after its creation, and remove the original XY data.  

 
17. Load the network files and any other chosen boundary file.  

 
18. Because the same Latitude and Longitude is used for all count locations, there is 
a possibility that multiple points may be placed on top of each other. It is 
recommended that the analyst take the time to go to each count location and move the 
counts to the proper leg of the intersection. 
 
19. The figure below shows what it will look like before and after the hand cleaning.  

 

     

 


	Appendix 17A – NETWORK COUNT ATTRIBUTION
	Network Creation
	Network Shapefile Creation in ArcGIS
	Network Shapefile Creation from Visum

	Network Count Attribution
	Visum Count Attribution
	Excel Processor Guidelines
	Excel Tube Count Processor (ATR Edit Sheet processor) Spreadsheet
	Excel Turn Count Processor (Intersection Video or TimeMark Count) Spreadsheet
	Exiting Volume Calculation Spreadsheet

	Count Locations in VISUM
	ArcGIS Count Attribution



